
Help is available for each item in this group. Click        at the top of the dialog box, and then click the specific item you want information 

about.



Lists the available columns that can be added to your message list.



Lists the columns currently displayed in your message list and the order in which they appear.



Moves the selected column from the Available columns list to the Displayed columns list.



Moves the selected column from the Displayed columns list to the Available columns list.



Moves the selected column up one in the Displayed columns list.



Moves the selected column down one in the Displayed columns list.



Restores the columns to the settings originally displayed when Outlook Express was first installed.



Lists the available news servers. For information about how to add news servers to or remove news servers from your server list, look up 

"Adding servers" in the Help Index.



Specifies that the list should display all newsgroups that contain the word you type here.



Lists the newsgroups available on the selected server. You can narrow this list to newsgroups that contain a specific word in the name or 

description. In addition, you can click the tabs to display all of the newsgroups available on the selected server or just the subscribed or new 

newsgroups available.



Specifies whether to limit the list of newsgroups to newsgroup names that contain the word you are searching for. If this box is selected, the 

list of newsgroups also includes newsgroups whose descriptions contain the word you are searching for. 



Opens the newsgroup selected in the Newsgroups list.



Adds the selected newsgroup to your Subscribed list. 



Removes the selected newsgroup from your Subscribed list.



Checks for new newsgroups on your server. If there are new newsgroups, Outlook Express downloads their names and descriptions, if 

descriptions are available.



Lists all the newsgroups on the selected server.



Lists only the newsgroups that you have subscribed to on the selected server.



Lists the newsgroups that have been added to the server since you last clicked Reset List.



Specifies whether to download the chosen number of messages when viewing a newsgroup or to download all messages in the newsgroup.



Specifies whether to display threads and all replies in the message list when you open a newsgroup. If you clear this check box, only the 

original message is displayed.



Specifies whether to mark a message as read after you have previewed it for the number of seconds indicated. If you clear this check box, you 

can still mark individual messages as read. For more information, look up "Marking messages as read or unread" in the Help Index.



Specifies whether to check your news server for new messages and send messages from your Outbox at the interval of minutes indicated. If 

you clear this check box, you can still check for new messages and send messages from your Outbox by clicking the View menu and then 

clicking Refresh.



Specifies whether to check for new newsgroups and download their names when you access a newsgroup server. If any are found, you can 

view the list of new newsgroups. If you clear this check box, you can still check for new newsgroups by clicking the Tools menu and then 

clicking Newsgroups.



Specifies whether to mark all messages as read when you exit a newsgroup. If you clear this check box, you can still mark individual 

messages as read. For more information, look up "Marking messages as read or unread" in the Help Index.



Specifies whether to display the body of a message in the preview pane whenever the header is selected in the message list. If you clear this 

check box, you can display the message body by selecting the header and then pressing the SPACEBAR.



Specifies whether to use Outlook Express whenever you click a link on a Web page to go to a newsgroup, or you choose the news command 

in your Web browser. If you clear this check box, then your browser will not use Outlook Express, and you must install another newsreader to 

view newsgroups from your browser.



Specifies whether you want to save in the Posted Messages folder copies of the messages you post to newsgroups. If you clear this check box, 

you can still save a copy of a message by including yourself on the Cc line of the message.



Specifies whether to automatically select whole words when selecting text in the body of your message. If you clear this check box, you can 

select text one character at a time, and you can automatically select whole words by double-clicking a word and extending the selection word 

by word.



Specifies whether to include the text of the original message when you reply to a message. You can edit or cut any of the text. If you clear this 

check box, the body of your message contains only the text you type or paste.



Specifies whether to indent the beginning of each line of original text included in your reply, preceded by the character indicated. This 

distinguishes the text you type from the text in the original message. If you clear this check box, then the original text and the text you add 

appear the same.



Click this to select advanced settings for sending messages, specifying message format and line length, and sending messages immediately.



Specifies whether a copy of each message you send is saved in the Sent Items folder. If you clear this check box, you can still save a copy of 

an individual message by including yourself on the To, Cc, or Bcc line of the message.



Specifies whether to use Outlook Express whenever you send e-mail replies to the author of a newsgroup message. If you clear this check 

box, then your browser will not use Outlook Express, and you must install another e-mail program to send messages.



Click this to select advanced settings for sending messages, including specifying the character set, message format, and line length, and for 

sending messages immediately.



Specifies whether to use a different international character set from the default character set associated with your Regional Settings in 

Control Panel. If you clear this check box, Outlook Express uses the default character set.



Specifies that Outlook Express should encode your messages using MIME. This is the common format used by most Internet mail programs. 



Specifies that Outlook Express should encode your messages using Uuencode. This format is commonly used to send binary files as 

attachments in messages posted to newsgroups.



Specifies whether Outlook Express should automatically wrap the text of outgoing messages so that each line is no more than the number of 

characters indicated. Some older Internet mail programs do not properly display messages with lines over 80 characters long. If you clear this 

check box, your message might appear to have extra line breaks to recipients whose mail or newsreading program can display only 80 

characters per line.

It is suggested that you set your limit to about 72 characters. Most mail and newsreading programs indent quoted text in replies or forwards. 

Setting the limit to 72 allows the message to be quoted several times without causing extra line breaks.



Specifies whether Outlook Express should immediately forward to your mail server any messages you send. If you clear this check box, 

messages you send are placed in your Outbox and are not sent until you click the Send and Receive button on the toolbar.



Lists the available bit and binary formats for encoding your message.



Shows how your text appears in outgoing messages. Recipients whose servers or e-mail programs do not support text formatting see the text 

displayed on their computers as plain text.



Shows how text appears in messages you receive as unformatted text. 



Shows how text appears in the original text included in your reply. Recipients whose servers or e-mail programs do not support text 

formatting see the text displayed on their computers as plain text.



Changes the font characteristics, such as font, font style, size, and color. 



Specifies whether to show suggested spellings for misspelled words found during a spelling check. If you clear this check box, Outlook 

Express displays misspelled words but it does not suggest correct spellings. However, you can still type the correct spelling in the box.



Specifies that Outlook Express should check the spelling in messages you send and give you a chance to change, ignore, or correct any 

misspelled words.



Specifies whether to ignore words in uppercase letters. This is useful when the text you are sending contains computer programming code, 

which is often in uppercase letters and uses character combinations that do not form identifiable words. If you clear this check box, Outlook 

Express checks words in uppercase for misspelling. 



Specifies whether to ignore words that contain numbers. If you clear this check box, Outlook Express checks words that contain numbers for 

misspelling.



Specifies whether to ignore misspelled words in the original text included in a reply or forward. If you clear this check box, Outlook Express 

checks the original text, in addition to your own, for misspelled words.



Specifies that Internet addresses are ignored when Outlook Express checks spelling. 



Enables you to specify the language to use when checking.



Click this to add words to or change words in your custom dictionary.



Specifies that no signature should be added to your messages.



Specifies that a text file should be used as a signature in your outgoing messages.



Specifies that you want to insert the contents of a text file as part of your signature. You can type the path and name of the file you want to 

use, or you can click Browse to locate the file.



Specifies whether to add your signature to all outgoing messages. If you clear this check box, outgoing messages do not contain your 

signature unless you add it to an individual message.



Specifies whether to add your signature to all outgoing messages except replies or forwards. If you clear this check box, outgoing messages 

do not contain your signature.



Displays a possible error, such as a misspelled word, a duplicate word, or incorrect capitalization. The word is highlighted in the message, so 

you can see it in the context in which it is used.



Proposes a replacement for the word displayed in the Not in dictionary box.

To replace the word that is displayed in the Not in dictionary box, you can:

· Accept the word listed in the Change to box by clicking Change.

· Type the correct word in the Change to box, and then click Change. 

· Double-click a word in the Suggestions list.

To delete the word from the document, delete the text in the Change to box, and then click Delete, or, to delete all instances of the word in 

the document, click Delete All.



Lists suggested replacement words from your dictionary when you click Suggest or if you have selected the Always suggest check box on the 

Spelling tab. 



Specifies the rules that Outlook Express uses to check spelling.



Reverses the most recent actions made during the spelling check. You can undo several changes by clicking Undo Last several times.



Leaves the word in the Not in dictionary text box unchanged.



Changes the word in the Not in dictionary text box to the word in the Change to text box.

If the Change to text box is empty, the button name changes to Delete. Click Delete to delete the selected word.



Adds the word in the Not in dictionary text box to the Outlook Express dictionary.



Closes this dialog box without saving any changes you've made.



Leaves all instances of the word in the Not in dictionary text box unchanged in your message.



Changes all instances in this message of the word in the Not in dictionary text box to the word in the Change to box.



Displays a list of proposed alternatives for a misspelled word.



Specifies whether you want your computer to play a sound when new messages arrive when you are running Outlook Express. If you clear 

this check box, you do not hear any sound when new messages arrive, but the Outlook Express status bar and message list indicate that you 

have unread messages.



Specifies whether a message should be marked as read after you have previewed it for the number of seconds indicated. If you clear this 

check box, messages are not marked as read unless you open the message in a message window, scroll the message in the preview pane, or 

select the message in the list, click the Edit menu, and then click Mark as Read.



Specifies whether to check your mail server for new messages at the specified interval of minutes. It also sends any messages in the Outbox at 

the same time. If you clear this check box, you can check for new messages only by clicking the Tools menu and then clicking Send and 

Receive. 



Specifies whether Outlook Express should permanently delete messages from the Deleted Items folder when you quit Outlook Express. If you 

clear this check box, deleted messages stay in the Deleted Items folder until you open that folder, select the messages, and then delete them.



Specifies whether you want to save copies of the messages you send in the Sent Items folder. If you clear this check box, you can still save a 

copy of a message by including yourself on the To, Cc, or Bcc line of the message.



Specifies whether to use Outlook Express whenever you click a link in a Web page to send an e-mail message, or choose the mail command in 

your Web browser.



Specifies that Outlook Express should send your messages in HTML format.



Specifies that Outlook Express should send your messages as plain text, with no formatting.



Click this to specify format settings for message encoding.



Specifies whether to start Outlook Express in the selected newsgroup. If this check box is cleared, Outlook Express starts in the newsgroup 

you were viewing when you last used Outlook Express.



Specifies whether foreign character sets, high ASCII, or double-byte character sets (DBCS) are allowed in the header without encoding. If this 

check box is cleared, these characters will be encoded.



Specifies whether Outlook Express should delete all newsgroup messages from your computer after they have been on your computer longer 

than the specified number of days.



Specifies whether Outlook Express should delete all read newsgroup messages from local storage on your computer when you quit Outlook 

Express.



Specifies that Outlook Express should compact storage files on your computer when the amount of wasted space exceeds the specified 

percentage.



Click this to compact, delete, or remove messages stored on your computer. 



Specifies that Outlook Express should download messages from all newsgroups that you subscribe to, from all servers that contain 

newsgroups that you subscribe to. 



Specifies that Outlook Express should download messages from only the subscribed newsgroups that you select, from all servers.

You can select individual subscribed newsgroups on one or more servers, or all subscribed newsgroups on individual servers.



Lists your newsgroup servers and the subscribed newsgroups on them, and provides a place to select servers or newsgroups to download.

To display the subscribed newsgroups on a server, click the plus sign (+) next to the server. 



Specifies that Outlook Express should download only the headers for the newsgroups you select to download. You can later view those 

headers and select which messages you want to download.



Specifies that Outlook Express should download the headers and message bodies for the newsgroups you select to download.



Specifies whether to download any new messages which have been posted more than the number of days you specify. If you clear this check 

box, all new messages will be downloaded.



Downloads messages now.



Lists the fonts available on your computer. Click a font, and then see what it looks like in the Sample area. You must select text before you 

can change its font.



Uses a font style to add emphasis to words and phrases in your message. Font formatting applies only to currently selected text.



Changes the size of the message text that is selected. Font size is relative and depends on the font selected, the size of the base font, and the 

browser you are using.



 Shows sample text with the selected font formatting. The sample text changes as you change formatting options. 



Changes the color of the selected text.



Provides a space for you to type the path and file name of the image. You can also click Browse to locate an image.



Provides a space for you to type text that you want displayed in place of the image when images are turned off or unavailable on the 

recipient’s computer. The alternate text is also displayed when the image is loading.



Click this to specify the settings you want to use to position the image in the file.



Positions the image on the page depending on your selection.

To do this Select this option

Align the bottom of the image with the baseline of the text. Bottom or Baseline

Align the middle of the image with the baseline of the text. Middle

Align the top of the image with the top of the largest item in a line. Top

Align the image with the left margin, allowing text to wrap around the image. Left

Align the image with the right margin, allowing text to wrap around it. Right

Align the top of the image with the top of the surrounding text. Texttop

Align the middle of the image with the middle of the line of text. Absmiddle

Align the bottom of the image with the bottom of the line. Absbottom



Places a border around the image in the width (in pixels) you specify. Type a number between 0 and 999.



Adds the specified amount of space (in pixels) to the sides of the image. Type a number between 0 and 999.



Adds the specified amount of space (in pixels) to the top and bottom of the image. Type a number between 0 and 999.



Specifies whether to create a link to the file you want to send.



Provides a space for you to select a file type and then type the address or path that you want to create a link to. 



Specifies whether to add a line under the selected text.



Click this to browse through folders to find the picture file you want.



Specifies whether, when you reply to e-mail, the names and e-mail addresses of recipients are added to the address book.



Specifies whether the contents of the Inbox are displayed when you first open Outlook Express.



Specifies whether replies to messages use the format of that message—either plain text or HTML. This setting overrides other formatting 

settings. 



Adds your digital signature to all messages you send, which enables recipients to verify that the message was not forged or tampered with.



Encrypts outgoing messages with your digital ID. By default, your digital ID is added to signed messages so that recipients can decrypt the 

message.



Click this to specify an encryption algorithm or to specify that your digital ID is not included with outgoing messages.



For people with modem connections to the Internet, this option specifies that your Internet connection number is not dialed when you start 

Outlook Express. If you select this option, use the Dial button on the toolbar to start an Internet connection.



Specifies which Dial-up Networking number Outlook Express uses when connecting to the Internet. This option is useful if you have more 

than one Dial-up Networking connection to the Internet.



When selected, specifies that a message appears when you start Outlook Express, asking if you want to start an Internet connection. This 

option is useful if you frequently read newsgroups or e-mail offline. 



When selected, specifies that if you have more than one Dial-up Networking connection, Outlook Express displays a message enabling you to 

cancel a connection that isn’t working.



Specifies that Outlook Express disconnects from your Internet connection after you click the Send and Receive button on the toolbar or 

download newsgroups for offline reading.



Specifies whether messages that have attached picture files (*.bmp, *.gif, or *.jpg) display the picture in the message after the message text. 



Specifies whether, in messages that have multiple attached pictures, the pictures are displayed one at a time in the message, with forward and 

backward buttons used to view additional images. 



Click this to set the font and text size of incoming messages.



Click this to review the list of character-set substitutions that you have previously used for incoming messages. Every time you change a 

character set in a message by using the Language button on the toolbar, you can add it to this list. Then, any incoming message 

with the same character set is automatically reformatted to the character set you specified.



Specifies whether all commands sent to and from the news server are saved in a log file. The log file is useful for troubleshooting.



Specifies whether all commands sent to and from the mail server are saved in a log file. The log file is useful for troubleshooting.



Specifies that commands sent to and from the news server when you download newsgroups for offline reading are saved in a log 

file. The log file is useful for troubleshooting.



Click this to set the font and size of outgoing message text.



Specifies that the font settings you selected are added to outgoing messages.



Adds the selected image to messages. The image appears behind message text.



Click this to select stationery to use for new outgoing messages. 



Click this to create a signature and/or include a Business Card in outgoing messages.



Specifies whether to add your signature to all outgoing messages. 



Specifies that the text you type is added to the end of outgoing messages.



Adds the file you specify to the end of outgoing messages.



Click this to search for files in your local or network folders to append to outgoing messages.



Specifies whether    your signature is added when you reply to or forward a message.



Click this to create a new address book listing to use in your stationery.



Click this to change contact information that you want to send as a Business Card.



Specifies whether to add the contact information for the specified person to outgoing messages. The contact information is in vCard file 

format, which can be read by any digital device.



Provides a space to enter a contact name from your address book to use as a Business Card. The Business Card is the contact information 

stored in a vCard file, which can be read by any type of digital device. If you do not have an entry for yourself in your address book, click 

New to create one. 



Lists the names of the stationery files on your computer.



Displays a small sample of the selected stationery.



Click this to start Microsoft FrontPage Express and edit the HTML file of the selected stationery.



Click this to start Internet Explorer, to view more stationery.



Click this to search for files to use for stationery in your local or network folders. 



any pictures in the message (including background images) are added to the message. If this option is cleared, only a reference (or pointer) to 

the picture is included. Use this option if the message recipient(s) do not have access to the picture (for example, if it is on your computer or if 

they are reading the message offline). Including pictures makes the message larger, and it takes longer to download.



Specifies whether to display a list of icons similar to Microsoft Outlook on the left side of the window.



Specifies whether to display a list of default folders (such as the Inbox, Outbox, and Drafts folders) and folders you create. The list appears on 

the left side of the Outlook Express window.



Specifies whether to display a horizontal bar between the toolbar and the message list that shows the name of the currently displayed folder.



Specifies that every time you start Outlook Express, a different idea for efficiently using it appears.



 Specifies that you want to move the toolbar to a particular area of the Outlook Express window.



Specifies whether to display the name of the toolbar button below the button.



Click this to add or remove buttons on the toolbar.



Specifies whether to display the preview pane, which shows the contents of the selected message.



Specifies that Outlook Express should to display the preview pane either horizontally (below messages) or vertically (beside messages), 

depending on your selection.



Specifies whether to display the information in the To, From, and Subject boxes of the message at the top of the preview pane.



Click this to learn more about digital IDs.



Click this to obtain a digital ID from a certifying authority. 



Click this to change the settings for your security zones. Note that these settings are also used by Internet Explorer.



Specifies the security algorithm to use when sending encrypted mail. You must use the same algorithm as the person you are corresponding 

with.



Specifies whether to send a readable (decrypted) copy of the mail to yourself.



Click this to send the digital ID of the message recipient.



Specifies whether the public key portion of your digital ID is sent whenever you send digitally signed mail. Mail recipients can use the public 

key to encrypt messages to you.



Specifies whether the digitally signed message uses PKCS#7, a widely used convention for containing the data used to sign an image or a 

document. It typically includes the digital ID of the signer and a statement about the image made by the signer. 



Specifies whether Outlook Express is used when you send documents from within other applications by using the Send command 

on the File menu. Selecting this check box disables both the Microsoft Exchange and Microsoft Outlook mail programs. 



Specifies that Outlook Express attempts to connect to your dial-up Internet mail account at the interval you set with the Check for new 

messages every xx minute(s) option. (Click the Options menu, and then click the General tab.)



Specifies whether all commands sent to and from the IMAP mail server are saved in a log file. The log file is useful for 

troubleshooting.




